
Key Travel Map CD-ROM for Windows

Tutorial #2: Creating a Delivery Route

Creating a Delivery Route

The primary purpose of a map is to provide a visual reference of a given area and to assist in moving from
point A to point B. Key Travel Map for Windows fulfills both of these functions, however, sometimes it is
necessary to plot a route that touches on or visits more than one location. Places to be visited can be found
using a paper map and the visual reference can be used to plan a route, but Key Travel Map for Windows
allows the user to use and re-use the original map and display.

It is often necessary for a business to visit more than one location: calling on a number of clients and the
delivering of goods are just two common examples.  Key Travel Map for Windows permits the user to
extend the logical use of a paper map by allowing the placement of key icons to represent any location. It
also allows a business route to be efficiently planned.

Working with the supplied Boston map, this second tutorial creates just such a map. The following actions
are carried out in this tutorial:

• Creation of an Overlay containing a number of addresses
• Selection of Icons for each of the addresses
• Place the icons onto the map to provide a visual reference to these addresses
• Use the created Overlay to plan a delivery route that is both logical and less time consuming

Step 1: Placing An Office on the Map

The  creation  of  the  Overlay  consists  of  entering  the  names  and  addresses  of  the  locations  to  which
deliveries are to be made. For routing purposes, since the deliveries or pick-ups initiate and terminate from
a particular office, data referring to the location of that office must also be entered.

At the Key Travel Map for Windows main screen, select the Boston Map  included with the Key Travel
Map for Windows program.

• Click on File in the Menu Bar.
• Click on Map Selection...
• Select the Boston  map by highlighting it and clicking on OK OR Press Enter.

NOTE: A map can be selected by clicking the Map Selection Tool in the Tool Bar.

The Boston map covers an area which is significantly larger than the Los Angeles map used in the previous
tutorial, therefore it is unlikely that all of the places to be visited will be readily visible on the map at any
one time. Locating an address can be done in two ways:

• Zooming in on the area and locating the street visually 
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• Using the Find Street feature to locate the address

The easiest (and fastest) method of locating an address is the second choice. As in the previous tutorial, one
of the features of the Find Street command is that it automatically rewrites the display with the selected
street (address) in the center of the screen. The street block itself is pinpointed with a "Map Pin".

For the project in this tutorial, an address is needed for the hypothetical office, or start/finish point. Make
the office address:

175 Stuart Street

To locate the office address there are two options:

• The Find Street feature in the Street Menu
• The Find Street Tool (the green Street Sign) in the Tool Bar

Using the Find Street Tool

To locate an address with the Find Street Tool:

• Click the Find Street Tool in the Tool Bar
• Enter the following information in the Street Search Dialog box.
• When the data has been entered, click Search OR Press Enter.

The Street Search Dialog Box

• The Search routine displays the following Dialog box.
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The Locate Street Dialog Box

NOTE: The address number shown for each street is the highest recorded address in each street block.

• Use the mouse to highlight 175 Stuart St. and click GoTo.

The screen is regenerated with the selected address displayed in the center of the screen. The address is
identified with a Map Pin. Zoom in on the area by either using the Zoom In option in the View Menu or
the Zoom In Tool in the Tool Bar.

The Selected Address after Goto
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Either option changes the cursor to a magnifying glass..

• Place the cursor close to the left and above the Map Pin and drag the cursor down, to below and
to the right of the Map Pin as displayed in the following figure.

Using the Zoom Feature

This increases the scale of the map so that the located address and the surrounding streets can be easily
identified.  Having identified  the office location on the  map,  an Overlay can be created  for  all  of  the
locations to be entered. Overlays are created from the Overlays Menu.

Step 2: Creating a New Overlay

To create a New Overlay, click Overlays in the Menu Bar or click on the Overlays Tool in the Tool Bar (the
Filing Cabinet).
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The Overlays Menu

From the Overlays Menu, select Open. Regardless of which option is selected, the Overlay File Selection
Dialog box is displayed.

The Overlays File Selection box

• The Dialog box lists all of the existing overlays in alphabetical order. To create a new overlay, 
highlight the entry at the top of the dialog box by clicking on it, then type a new name.

NOTE: Remove the listing only, do not delete the file!

• Type the new name: DELIVERY.

The  name  can  have  a  maximum  length  of  eight  characters,  and  Key  Travel  Map  for  Windows
automatically adds the DBF extension when the Overlay is saved. After the name has been entered, click
OK OR Press Enter.
Since the Overlay being created does not presently exist, the following is displayed.

Creating a New Overlay

• Click Yes OR Press Enter and Key Travel Map for Windows creates the Overlay file and the 
Overlay Input Dialog box is displayed with all of the data fields empty.
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There are two entries (fields) which must be filled in the Overlay Input Dialog box. These are the Group
and Name fields.

The Group field is used to relate records into logical sets. All of the entries associated with a group are
listed together. The Overlay is a database i.e. a collection of records.

Since  the  entries  to  be  made  are  a  number  of  related  addresses,  the  Group  field  has  been  called
DELIVERIES.  This facilitates  differentiation between entries  with different  classifications in the same
database (e.g. PICKUPS and DELIVERIES).

After the data for the office, or main depot, has been entered, the Overlay Input Dialog box is displayed as
shown below:

The Data for the MAIN DEPOT

Selecting an Icon

Key Travel Map for Windows comes with a number of different icons. Icons are selected by clicking on
the arrow buttons to the right of the Icon box near the top of the Overlay Input Dialog box.

• To select  the  check  mark  icon,  click on the down button next  to  the Icon  box until  it  is
revealed.

• After the icon has been selected and all of the information has been entered as shown above,
click Add. This places the record into the overlay database.
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The next step is to place the icon on the map at the Main Depot's location. After Add is clicked in step 1,
the Overlay Input Dialog box data fields are cleared of information (the fields are emptied of data, ready
to be filled in with the next record's information).

• Click Find.

The display changes and a box is displayed over the Overlay Input Dialog box, showing all  of  the
listings in the Overlay. At present there is only one.

The Find Record Command

• After the Find box containing the listing(s) is displayed, highlight the desired listing and click 
OK.

The Find box is cleared and the Overlay Input Dialog box shows the selected Main Depot record. (As in
the previous figure).

• To place the icon on the map, click Geocode.

Geocode provides the means for placing the icon anywhere on the Boston map. Upon clicking Geocode,
the Overlay Input Dialog box is removed and the previous map is displayed, with the Map Pin still
indicating the address found in Step 1 at the beginning of this tutorial. The cursor changes to a circle
with a super-imposed cross.

• Position the cursor a little below and to the left of the Map Pin as shown in the following
diagram, and click the LEFT mouse button.
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This action places the check mark Icon onto the map as a visual reference for the Main Depot's location
and the Overlay Input Dialog box is displayed.

Placing an Icon onto the Map

To verify the icon's placement, perform the following:

• Click Plot.

• Click Hide to remove the Overlay Input Dialog box from the display. The map shows the icon
as in the following figure.

If the icon is not displayed, click on the Overlays Menu to verify that Show Objects is turned on. A tick
appears beside the Menu item. If not, click on Show Objects and the icon is displayed.

To return to the Overlay Input Dialog box:

Click on Update in the Overlays Menu. The Overlay Input Dialog box is displayed, with the fields empty.
Click Find as in step number 3. Since the only existing entry is highlighted, click OK. The Overlay Input
Dialog box now has the fields filled with the previously entered information. Click on Hide.
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Labeling the Icon

Key Travel Map for Windows has a number of labeling features which permit the user to insert notes or
descriptions anywhere on the map. These notes can be addresses, special directions, a unique description 
for an icon; in short, any information that might help in the use of the map.

Since the first entry was the Main Depot, label it as such using the Add Text feature.

To place a label below the Main Depot Icon:

• To return to the map, click on Plot and then on Hide. 
• Click on the Illustrate Menu and then on Add Text. When the map display is returned, move the 

"I-bar" cursor to just below the icon as shown in the following illustration.

Placing Text on the Map

• Type MAIN DEPOT in the Add Text Box and Press Enter. The map is regenerated with the  
added text as displayed in the  figure on the following page.

Placing Text on the Map

The text added bears the same characteristics and attributes assigned to User Text in the Preferences Menu.

To edit or remove the text, click on it and the Text Dialog box is displayed.
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The Text Dialog box

To edit the text, type over the text which has already been entered. Click on Delete to remove the text from
the map.

Using the Delete command in this Dialog box removes the text completely. The text can be turned off
(along with any other text or notes added) by clicking on the Visible feature in the Illustrate Menu.

When there is a check mark beside the Visible feature in the Illustrate Menu, all labels are displayed on the
map.

In addition, the Delete All command in the Illustrate Menu permanently removes all notes or text placed on
the map.

Step 3: Locating Other Addresses

To add the remaining addresses to the map and to the Overlay, repeat the procedures shown below for each 
location on the delivery route.

• With the map displayed on the screen, use the Find Street Tool to locate each address.
• Click GoTo to enter the address.
• Select Update in the Overlays Menu and fill in the required information in the Overlay Input 

Dialog box.
• Add the record to the Overlay by clicking on the Add button.
• Click Geocode and position the icon at the correct location.
• Click Plot then Hide to display the icon on the map.
The above instructions assume that the Overlay initially created in this tutorial is still open.

NOTE: To save this session so that work may be continued at a later date, refer to the description of the 
Save Session command and Tool in Chapter 2.

The information for the next address is as follows:

Hawthorne Gable Service
55 Longfellow Bridge Access St.

To locate this address:
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• Use the Find Street Tool to enter the search data.
• Highlight the listing which closely corresponds to the desired address and click GoTo.

Finding the Second Address

This centers the address on the map with a Map Pin identifying its location.

• Click on Update in the Overlays Menu and enter the following information:
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Entering the 2nd Record's information

The Icon

Use the Yellow House as the identifying icon. Click on the icon down arrow until the house is displayed in
the Overlay Input Dialog box.

Other Information

Phone numbers, mailing information and comments can be filled in for practice.
• Click on the Geocode button and place the Icon on the map.
• Click on the Add button to add that record to the overlay.
• Click Plot then Hide to show the second icon on the map.

Using the same sequence, locate the following addresses and add the relevant information to the Overlay.
The only fields which must be filled in are GROUP and NAME.

GROUP: DELIVERIES (for all)

NAME: MELVILLE WHALE OIL
ADDRESS: 41 PARKMAN ST.
ICON: RED FISH

NAME: DREISER DREAM CO.
ADDRESS: 88 MOUNT VERNON ST.
SYMBOL: SMILING FACE

NAME: WILLIAMS SPORTING GOODS
ADDRESS: 66 BEACON ST.
SYMBOL: PYRAMID

NAME: COOPER PATHFINDER INC.
ADDRESS: 120 RICHMOND ST.
SYMBOL: CAR & MAP

NAME: VAN WINKLE MATTRESS CO.
ADDRESS: 99 SLEEPER ST.
SYMBOL: BEER MUG

NAME: ZIMMERMAN MUSIC WORKS
ADDRESS: 200 A ST. (SOUTH BOSTON)
SYMBOL: TREBLE CLEF (Music Symbol)

NAME: OCHS NEWS SERVICE
ADDRESS: 35 HERALD ST.
SYMBOL: LARGE BULB
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NAME: PAXTON TRAVEL SERVICE
ADDRESS: 441 TREMONT ST.
SYMBOL: BOAT

NOTE: The sequence outlined in step 3 allows each address to be located individually BEFORE entering
the data into the Overlay. This is purely for icon placement purposes. It is not necessary to use the Find
Street Tool in order to add the data into the Overlay.

After all of the locations have been entered into the Overlay and the icons placed on the map, reset the
display scale to 3.0 miles and the display looks like the following figure:

All the icons placed on the Map

Printing a Copy of the Map

When all of the icons have been placed on the map, there is a visual reference for planning a route. The
map shown in the previous figure can be printed at any time using the Hardcopy.. feature (or the Print
Tool). Refer to a Windows Manual for information on printing.

If the Print Manager is used, Key Travel Map for Windows may behave very sluggishly, depending on the
processing speed of the computer and the Windows configuration.

Depending on the amount of memory available in the printer, it may not be possible to print the complete
map at the highest resolution. Should this occur, change to a lower resolution in the Printer Setup and
Options. Refer to the Windows manual and the printer documentation for more information.

Transferring the Map to the Clipboard

The Copy Tool on the Tool Bar, or the Copy function from the Edit Menu, can be used to capture the screen
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to the clipboard.  The map can then be printed at a later date using any number of graphics or word-
processing programs.

NOTE: Saving a map to the clipboard over-writes everything on the clipboard. Refer to the Windows
manual for further information on manipulating images that are transferred to the clipboard.

Saving the Session

Save the session by using the Save Session.. feature from the File Menu, or the Save Session Tool - the
Camera. Saving the session allows the current map to be retained for future use, including all the current
Preference settings and Overlay information.

Step 4: Planning A Route

The map on the screen allows the user  to  view the projected  pick-up or  delivery  points  to  create an
optimum routing for the drivers. As mentioned previously, this can be done directly from the screen or from
a printed copy. When all of the delivery addresses are on the map (identified by icons), a route can be
planned. Sometimes, what appears to be the most logical route may not be, since many factors such as
business hours, making pickups as well as deliveries, etc., must be taken into account.

Visual planning of the route is simplified if a printed hardcopy of the map is available. Referring to the
previous figure with the caption All of The Icons Placed on the Map, a number of possibilities are available.
The basic route needs to be circular.

In a real life situation the actual planning of the route would take into consideration many factors such as
times, deadlines, opening hours, etc. This exercise is designed to give the user a feel for planning and
creating the route.

Key Travel Map for Windows permits a Starting Point, an Ending Point (Start Street and Finish Street)
and a number of Intermediate points to be entered. When Key Travel Map for Windows creates the route
these Intermediate points are considered in the order they were entered. To prevent unnecessary doubling
back,  consider  the  route possibilities  by inspecting the map either  on the screen,  or  by referring  to  a
hardcopy.

In order to simplify planning a route on the screen, use the Add Text feature to number the locations in the
order they are to be visited.

Using Add Text for Clarification

A visual inspection of the map presents several possibilities for the eventual route. The starting and ending
points are the Main Depot. One order is:

Start: MAIN DEPOT
Stop 1: Paxton Travel Service
Stop 2: Williams Sporting Goods
Stop 3: Hawthorne Gable Services
Stop 4: Dreiser Dream Co.
Stop 5: Melville Whale Oil
Stop 6: Cooper Pathfinder Inc.
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Stop 7: Van Winkle Mattress Co.
Stop 8: Zimmerman Music Works
Stop 9: Ochs News Service
End: MAIN DEPOT

Numbers can be placed next to each of the icons to assist in plotting the route.

Using the Add Text feature in the Illustrate Menu the user can make the map look like the one displayed in
the following figure.

Adding Numbers to the Map

Notice that an arrow has been placed in the top right of the display, from the number 6 to the Map/Car icon,
because the number of streets around that icon would have made the number unreadable.

Although the numbers added to the previous display are close enough to each icon to be of use, note that
zooming in changes the scale of distance both in the structure of the map and with the placement of any
text. Zooming in around Stop #3 produces the following:
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Zooming In - the numbers seem to move

Therefore, if a portion of a map containing text is printed (with a larger scale), the numbers or text may not
appear to "belong" to the correct element.

Place text after zooming in. The text would be displayed as in the following figure:

Positioning Text for clarity

In the previous example, the text placement was done after setting the scale at 0.9 miles (the largest city
scale).

Bear  in  mind,  however,  that  correctly  placed  text  at  the  larger  scale  changes  position  when the  area
displayed is increased. Always consider why any text is being placed and what use is to be made of it.

Step 5: Identify the Starting Point

Before plotting points for a route, a list of all the destinations is needed. For the purposes of this tutorial,
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the required addresses can be found earlier in this chapter.

The starting point in this case would be the Main Depot, 175 Stuart St.

Zoom In to the Area

When the map is at wide scale (i.e. the entire city is displayed), clicking on a specific street can be difficult.
Zooming In on a desired area with the Zoom In Tool (or by changing the scale of the display) alleviates this
problem. Begin by zooming in on the area around the office since this is the start point.

The Zoom In Tool

To zoom in on the office, click on the Zoom In Tool in the Tool Bar and drag the magnifying glass so that
the Zoom Box covers the office icon. Key Travel Map for Windows redraws the screen to the new scale,
with the streets around the Main Depot icon readily visible.

NOTE: If the Zoom box is made too small, an alert is displayed - Zoom Exceeds Max. Key Travel Map
for Windows then defaults to the smallest scale and zooms in on the covered area.

The Start Street

To choose the Main Depot as the Start Street use the Start Street feature in the Street Menu or the Start
Street Tool.

Clicking on the Start Street Tool (the Green Car in the Tool Bar) turns the cursor into a checkered flag.
Position the bottom of the flag on Start Street and click the LEFT mouse button. The following dialog is
displayed:

Selecting the Start street

If the LEFT mouse button is clicked on an area of the map where there is no street, the following dialog
box is displayed:
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No Street selected

If the cursor is positioned correctly, the screen is regenerated and the Start flag is displayed on the selected
city block.

The Start Street successfully selected
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Step 6: Identifying Intermediate Points

Identifying the Intermediate or Via Points is essentially the same procedure.

• Zoom In on the area where the point is located
• Click on the Intermediate Point Tool (the Blue Car) in the Tool Bar
• Position the checkered flag cursor on the desired street and click the left mouse button

In order to Zoom In on an area, the desired point must be within the display. The first intermediate point,
for instance, PAXTON TRAVEL SERVICE, should be just off the bottom of the display and to the left if
the MAIN DEPOT is centered on the screen and the display scale is set to maximum (0.9 miles).

There are two methods for zooming in on a particular area:

• Use the Find Street Tool to locate the street, then click GoTo
• Scroll the map to display the desired location using the Scroll Buttons or the Map Center Tool  

(the Bull's eye) in the Tool Bar.

NOTE: If a listing of addresses is not immediately available, the user can use the Overlay to find exact
street names and numbers. Use the Find command in the Overlay Input Dialog box to display information
on any item in the overlay.

The Scroll Buttons

The scroll buttons can be found to the right and the bottom of the Key Travel Map for Windows screen.
Clicking on the arrows move the map in increments in the direction of the arrow right or left, up or down.

The Map Center Tool is used to designate any point on the map as the new center of the the display.

By placing the Map Center cursor anywhere on the map and clicking the left mouse button a new display
with a new center point is created while maintaining the same display scale.

Before plotting the intermediate points (everything between the start and end points), it is important to note
that  Key Travel Map for Windows only accepts a maximum number of 10 intermediate plot points. If
there are more than 10 points, create two routes, using the Finish Street on the first route as a new starting
point for the second.

In this tutorial the user is supplied with 9 intermediate points and an office address for the location, which
falls within the parameters of Key Travel Map for Windows' capabilities.

The  Intermediate  Points  are  selected  by  using  the  Intermediate  command  in  the  Route  Menu  or  the
Intermediate Tool from the Tool Bar.

The Intermediate Street Tool is used in the same way as the Start Street Tool. Once selected, the cursor
turns into a checkered flag and the base of the flag is placed on the desired city block or street/roadway.

Clicking the LEFT mouse button places an INT Flag at the selected point.
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NOTE: Whenever Tools are selected from the Tool Bar, a description of the Tool appears in the Status line
just above the Scroll Bar in the bottom left of the screen.

The steps for identifying the nine intermediate points are as follows:

• Redraw the map so the street to be selected is easily discernible in the display. Scroll the map 
with the Scroll Buttons or Map Center Tool or use the Find Street command/tool to

achieve this.

• Click on the Intermediate Tool in the Tool Bar.

• Place the base of the flag on the desired street and click the left mouse button.

Repeat the previous three steps for each Intermediate Point.

Refer to the listing of addresses earlier in this chapter or use the Find command in the Overlay Input Dialog
box to find specific addresses. After all of the Intermediate or Via Points have been selected, the user must
select the Finish Street, which is the same as the Start Street.

Step 7: Identifying the Finish Street

The Finish Street Tool is used to identify the street at the end of a route.

The Finish Street  Tool (the Red Car) in the Tool Bar functions in the same way as the Start Street or
Intermediate Street Tools. Click on the tool to turn the cursor into a checkered flag and position the base of
the flag on the desired street.

Click the LEFT mouse button and an END flag appears at the chosen location. After placing the Finish
Street, the map should like the following figure:
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Boston Map with all Points flagged

Creating the Route

After all of the points on the route have been flagged, check that Auto Scale is turned on in the Route Menu
and the route can be created.

Either the Go Tool or the Create Route command in the Route Menu is used to create the route. Clicking on
the Go Tool tells Key Travel Map for Windows to go ahead and map the route and produce the Driving
Instructions.

Click on the Go Tool and in a few seconds the route is displayed on the screen in a contrasting color. The
default color is yellow.
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The Route on the Map

After the route has been created, it is advisable to print the driving instructions.
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Step 8: The Driving Instructions

When  Key Travel  Map for Windows creates  a  route,  it  also creates  a  set  of  driving  instructions or
directions. These can be printed immediately after creating the route.

NOTE: After the Route is cleared, the Directions are no longer available.

To print these directions, click Route in the Menu Bar and select Show Directions..

The Driving Instructions

The full extent of the Driving Instructions can be seen by clicking on the scroll buttons to the right of the
information box or by using the up and down arrows on the keyboard.

To print the directions, click Print.

NOTE: Directions may vary, depending on the Route IQ settings.After the directions have been printed
names and addresses can be added to the indicated Intermediate Points.

The Directions are created in an ASCII file in the directory where  Key Travel Map for Windows was
initially  installed.  The file  name is:  _ROUTE.DIR.  This  file  can be copied and edited in  most  word-
processors. Check the word-processor documentation to see how to edit an ASCII file. The _ROUTE.DIR
file is OVERWRITTEN each time a new route is created.
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